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 Lesson 1 : Computer Networking

A. Multiple choice questions : 

1. WAN 2. Intranet

3. Server 4. Simple Mail Transfer Protocol

5. SMTP

B. State true or false :

1. True 2. False

3. True 4. False

5. True 6. True

C. Fill in the blanks : 

1. LAN 2. collection

3. POP 4. HTTP 

5. intranet

D. Answer the following questions in short: 

1. A protocol is a set of rules to govern the data transfer 

between the devices. 

2. Topology refers to the layout of connected devices on a 

network.

3. A gateway is a network device that allows the data to 

flow between two different network which may use 

different protocol.

4. Client : It is a computer which depends on the server 

for all the resources. For example, a server might store a 

network version of Excel program. 

Server : A server is also called host computer. It controls 

the access to the hardware and software on the 

network. 

5. Advantages of ring topology are :

✎ One computer cannot monopolize the network.

✎ It continues to function even after the capacity is 

exceeded but the speed becomes a bit slow. 
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E. Answer the following questions in detail :

1. A computer network is a collection of two or more 

connected computers. When these computers are 

joined in a network, people can share their files, and 

peripherals, such as modems, printers, tape backup 

drives, or CD-ROM drives.

Advantages of computer network :

✎ The information can be easily shared with each 

other.

✎ It reduces cost of hardware.

✎ Store information in one centralised location.

✎ Reduction in installation cost.

2. The basic types of networks include :

✎ Local Area Network (LAN)

✎ Wide Area Network (WAN)

✎ Metropolitan Area Network (MAN)

✎ Personal Area Network (PAN)

Local Area Network : A local area network (LAN) is a 

network that is confined to a relatively small area. It is 

generally limited to a geographic area such as a lab, 

school, or building.

Metropolitan Area Network : A metropolitan area 

network (MAN) covers larger geographic areas, such as 

cities, schools, or districts. By interconnecting smaller 

networks within a large geographic area, information is 

easily distributed throughout the network.

Wide Area Network : Wide area network (WANs) 

connect larger geographic areas, such as Florida, the 

United States, or the world. Dedicated transoceanic 

cabling or satellite uplinks may be used to connect this 

type of network.

PAN (Personal Area Network) : These are privately 
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owned network. PAN is used to establish the 

communication amongst the computers within the 

range of 20 to 80 feet. It can be wired or wireless.

3. Components of Computer Network :

Sender : A sender is a computer that wants to send 

information to other computer connected to the 

network.

Receiver : A receiver is a computer which is expecting 

the data from other computer on the network.

Transmission medium : It is a communication channel 

through which information is transferred from one 

computer to another on a network.

Message : A message is the information or data which 

needs to be transferred from one computer to another.

Protocol : A protocol is a set of standard rules used for 

communication.

4. Star Topology : A star network has a central 

connection point-like a hub or a switch. While it takes 

more cables, the benefit is, that if a cable fails, only one 

node is brought down.

Advantages of star topology are :

✎ The failure of a single computer or cable doesn’t 

bring down the entire network.

✎ The centralized networking equipment can reduce 

costs in the long run by making network 

management much easier.

Disadvantages of star topology are :

✎ Failure of the central hub, causes a whole network 

failure.

✎ It is slightly more expensive than using bus 

topology.
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5. Comparison Between Peer-to-peer networks and 

client/server networks

Peer-to-peer networks :

✎ Easy to set up

✎ Less expensive to install

✎ Can be implemented on a wide range of operating 

system

✎ More time consuming.

✎ Does not require a server

Client/server networks

✎ More difficult to set up

✎ More expensive to install

✎ A variety of operating systems can be supported 

on the client computers, but the server needs to 

run the operating system that supports 

networking.

✎ Less time consuming.

✎ Requires a server, for running a server operating 

system.

6. A protocol is a set of rules to govern the data transfer 

between the devices. 

Types of Protocols 

1. Transmission Control Protocol (TCP) 

2. Internet Protocol (IP) 

3. Internet Address Protocol (IP Address) 

4. Post Office Protocol (POP) 

5. Simple Mail Transfer Protocol (SMTP)

6. File Transfer Protocol (FTP)

7. Hyper Text Transfer Protocol (HTTP)

8. Ethernet 
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9. Telnet 

10. Gopher 

 Lesson 2 : Advance Features of MS Excel

A. Multiple choice questions: 

1.  Chart area 2. Data series

3. Legend 4. Input Message

5. Freeze

B. State true or false :

1. True 2. True

3. True 4. True

5. True

C. Fill in the blanks : 

1. chart 2. data marker

3. Axis 4. Data validation

5. freeze pane

D. Match the following :

1. (a) 2. (b) 3. (c)

4. (d) 5. (e)

E. Answer the following questions in short: 

1. A chart is a tool in MS Excel that is used to 

communicate our data graphically. A chart can allow us 

to know the meaning behind our data. 

2. We can easily change a chart type at any time. 

Following are the steps to change a chart type :

a. Select the chart.

b. On the Insert tab, in the Charts group, choose 

Column, and select Clustered Column.

3. Select the chart. We will notice that the Chart Tools 

contextual tab is activated

On the Design tab, click Switch Row/Column.
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4. Types of Chart

• Pie Chart • Column Chart

• Line Chart • Bar Chart

• Area Chart • Scatter Chart etc.

5. Data Tools are simply tools which make it easy to 

manipulate data. Some of them are used to save our 

time by extracting or joining data and others perform 

complex calculations on data.

6. Following are the steps to do so :

✎ Select the sheet which we want to hide.

✎ Now Click Hide Sheet from Hide & Unhide 

options from Cell group in Home Tab.

✎ Click on Hide Sheet Option from Hide and 

Unhide.

F. Answer the following questions in detail :

1. Type the data in our excel worksheet.

Before making a chart first of all we need to define a 

data series. A data series is a related set of data points. In 

an Excel worksheet it is usually one row of data with the 

associated column headings or one column of data with 

the associated row headings.

To create a line chart, the steps are as follows :

✎ Select the range A1:C6

✎ On the Insert tab, in the Charts group, choose  

Line, and select Line with Markers.

2. Elements of a Chart

✎ Chart area ✎ Data marker (or Data point)

✎ Data series ✎ Axis

✎ Tick mark ✎ Plot area]

✎ Gridlines ✎ Chart text

✎ Legend 
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3. To separate the contents of one Excel cell into separate 

columns. For this we can use the 'Convert Text to 

Columns Wizard'.

Steps are as follows :

1. Type the data in our worksheet.

2. Select the range with full names.

3. On the Data tab, click Text to Columns.

4. Choose Delimited and click Next.

5. Clear all the check boxes under Delimiters except 

for the Comma and Space check box.

6. Click Finish.

4. Data validation is a powerful feature that is used to set 

up certain rules to dictate what can be entered into a 

cell. For example, we may want to limit data entry in a 

particular cell to whole numbers between 0 and 10. If 

the user makes an invalid entry, we can display a 

custom message.

To create a data validation rule, the steps are as follows :

1. Type the data in our excel worksheet.

2. Select cell C2.

3. On the Data tab, click Data Validation.

5. Split worksheet is division of the active worksheet into 

two or more new worksheets based on unique values.

To split worksheet into upper and lower parts, steps are 

as follows :

1. Click the split box above the vertical scroll bar.

2. Drag it down to split your window.

3. Notice the two vertical scroll bars.

For example : use the lower vertical scroll bar to 

move to row 49.

6. We can use Freeze option if we have a large table of 

data in Excel. We can freeze either rows or columns. 

This way we can keep rows or columns visible while 
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scrolling through the rest of the worksheet.

Freeze Top Row : To freeze the top row, execute the 

following steps.

1. On the View tab, click Freeze Panes, Freeze Top 

Row.

2. Scroll down to the rest of the worksheet.

 Result : Excel automatically adds a black horizontal line 

to indicate that the top row is frozen.

G. Define the following :

1. Plot area : It is the area where our data is plotted and it 

includes the axes and all markers that represent data 

points.

2. Gridlines : It make easier to view the data values 

represented by the tick marks.

3. Tick mark : It is a small line intersecting an axis. 

4. Data validation : Data validation is a powerful feature 

that is used to set up certain rules to dictate what can 

be entered into a cell.

5. Chart Title : Chart title is a content control placed at 

the top of each chart control. 

6. Error Alert : If users ignore the input message and enter 

a number that is not valid, we can show them an error 

alert.

 Lesson 3 :

A. Multiple choice questions: 

1.  Access 2. Table

3. Data items 4. For Delete, Create table, Update

5. Data types 6. Filtering

B. State true or false :

1. True 2. True 3. True

4. True 5. True
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C. Fill in the blanks : 

1. RDBMS 2. data type

3. Auto number 4. Currency

5. table 6. Primary Key

D. Match the following :

1. (c) 2. (d)

3. (e) 4. (f)

5. (b) 6. (a)

E. Answer the following questions in short: 

1. The components of MS Access are reports, queries, 

forms and table.

2. Data types that are used in MS Access are text, number, 

date and time  yes/no, currency Auto number, Memo, 

OLE Object, Calculated. 

3. The advantages of MS Access are :

✎ Easy to install and use.

✎ Large amount of data.

✎ Easy to integrate. 

4. Record is a set date stored in a table.

5. A table is a database object that you define and use to 

store data update DATA. A table consists of records and 

fields. The difference ways to create table :

✎ Creating tables in datasheet view : In datasheet 

view, you can enter data into a new table without 

first defining the table structure.

✎ Creating tables in design view : When you create a 

table in Design view, you have more control over 

the databases design.

6. Forms is a graphical representation of a table, in which 

we used can insert new data , change the present data 

or even can delete it. Forms and tables use similar data. 

Whenever we change any record in form, it will 

automatically change in table.
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7. Reports in Access allow you to print assembled data in a 

custom layout. 

F. Answer the following questions in detail :

1. Before designing a database you must have to follow 

some guidelines.

✎ Identify all the fields needed by you to produce 

the required information.

✎ Organize each piece of data into its smallest useful 

part to make the design perfect.

✎ Make group related fields into tables.

✎ Determine each table's primary key which will 

uniquely identified.

✎ You will have to include a common field in related 

tables.

2. Creating tables in datasheet view

In datasheet view, you can enter data into a new table 

without first defining the table structure.

✎ On the create tab, in the tables group, click the 

table button. A new blank table opens in the 

object window in datasheet view.

Adding fields by entering data : Entering data in 

datasheet view is very similar to entering data in an 

excel worksheet. The main restriction is that data must 

be entered on contiguous rows and columns. 

3. To create a table in Design view :

✎ On the create tab, in the Table Design button. A 

New, blank table opens in the object window in 

Design view.

✎ In the field name column, type a name for the first 

field. Field names can be up to 64 characters long. 

They can include any combination of letters, 

numbers, spaces, and brackets etc.

✎ In the data type column click the down arrow and 
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select a data type from the list.

✎ In the description column, type a description for 

the field.

✎ Repeat steps 2 through 4 to add additional fields 

to the table. After entering the all fields save the 

table.

4. Filters is the concept in MS-Access which allow you to 

view only the data you want to see. 

To create a filter

✎ Click the drop-down arrow next to the field you 

want to filter by.

✎ A drop-down menu with a checklist will appear. 

Only checked items will be included in the filtered 

results.

• Select and deselect items one at a time by 

clicking their check boxes.

• Click Select All to include every item in the 

filter. 

• Click Blank to set the filter to find only the 

records with no data in the selected field.

✎ Click OK. The filter will be applied. 

5. Sorting : Arranging both text and numbers in ascending 

or descending order is called sorting. 

Steps to sort are as follows :

✎ Select a field in the cell you want to sort by. 

✎ Click the Home tab on the Ribbon, and locate the 

Sort & Filter group.

✎ Sort the field by selecting the Ascending or 

Descending command.

(a) Select Ascending to sort text A to Z or to 

sort numbers from smallest to largest

(b) Select Descending to sort text Z to A or to 

sort numbers from largest to smallest.
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✎ The table will now be sorted by the selected field.

✎ To save the new sort, click the Save command on 

the Quick Access toolbar.

G. Define the following :

1. Data types : Describes the kind of information in the 

field. 

2. Tables : A table is a database object that you define and 

use to store data update DATA.

3. Forms : It is a graphical representation of a table.

4. Queries : Query is in a database is a request for 

information from a DBMS. 

5. Reports : It allows you to print assembled data in a 

custom layout.

6. Sorting : Arranging both text and numbers in ascending 

or descending order. 

 Lesson 4 :  Adobe Photoshop

A. Multiple choice questions: 

1. Title Bar 2. Action Palette

3. Blur 4. Dodge

5. Hue

B. State true or false :

1. True 2. True

3. True 4. True

5. False

C. Fill in the blanks : 

1. Adobe Photoshop is an image

2. Zoom 3. healing brush

4. crop 5. Burn

D. Give the tools activated by following alphabet :

1. Path Selection 2. Brush
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3. Crop 4. Eraser

5. Gradient 6. Hand

7. Eye dropper 8. Healing brush

9. Slice 10. Marquee

11. Pen 12. Horizontal type 

E. Answer the following questions in short : 

1. Adobe Photoshop is an image processing software 

mainly used for photo retouching and manipulating 

image using some image base you may also create some 

original piece of art.

2. Palette are the small window screen. It helps you to 

monitor and modify the images. 

3. Lasso Tool lets you draw both straight edged and 

freehand segments of a selection border.

4. Colour modes determines the colour model used to 

display and print image.

5. You can get the image duplicated by following steps :

Step 1 : Click on Insert menu

Step 2 : Select duplicate from the list

The current picture will be duplicated

F. Answer the following questions in detail :

1. Features of Adobe Photoshop 

✎. New Paint Symmetry : This feature allow you to 

draw reflected strokes by using pen, pencil and 

brush tools.

✎. Rich Tool Tips : This feature display tips of using 

tool in form of text or video.

✎. Artificial Intelligence Assisted Upscale : This 

feature preserve important details and texture.
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✎. Easy Copy and Paste Layers : This feature allows 

you to copy and paste layers within a document 

and among documents. 

2. The opening screen of Photoshop consist of :

A. Title Bar : This indicates the name of software, file 

name, control button and also the size of the work 

area in percentages.

B. Menu Bar : Menu bar gives the display of different 

menu used to perform different task on the 

software. 

C. Tools Option Bar : This is the bar which displays 

the options available by software. 

D. Palette : Palette are the small window screen. It 

helps you to monitor and modify the images.

3. Hue : The word refers to the shade of colour being used 

in an image. It is generally identified by the name of the 

color. While adjusting the Hue of the colour it changes 

the value of color as it move around the color wheel.

Saturation : In Saturation the colour scheme Shifts 

away or towards the center of the colour wheel and so 

you can find the difference in the image.

To change the saturation you can change the sliders of 

saturation in any of the following way.

Move Right  : To increase the saturation.

Move Left   : To decrease saturation

4.  The act of cutting the unwanted part from the image is 

called Cropping. 

The image can be cropped by the crop tool. Select the 

crop tool from the toolbox, select the area in the Image 

that you need to crop.

Photo paint will display a confirmation box as waiting 

for your confirmed answer as soon as you give positive 
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confirmation, the final image appears after cropping.

5. The steps given below as :

Step 1 : Click on File menu

Step 2 : Select Save from the list

Step 3 : Give the file name

G. Give the use of following tools :

1. Rectangle Marquee Tool : Rectangle Marquee tool is 

used to make a rectangular selection.

2. Elliptical Marquee Tool  : It is used to make an elliptical 

selection.

3. Lasso Tool : Lasso Tool lets you draw both straight 

edged and freehand segments of a selection border.

4. Eraser Tool : The Eraser Tool changes pixels in the image 

as you drag through them. If you are working in the 

background, then the pixels change to the background 

colour otherwise, the pixels are erased to transparent.

5. Gradient Tool : The Gradient Tool create a gradual 

blend between multiple colour. You can choose from 

present gradient files or create your own. 

6. Blur Tools : The blur tools softens hard edges or areas in 

an image to reduce detail.

7. Rectangle Tool : Rectangle Tool is used to draw 

rectangles.

8. Line Tool : Line tool is used to add lines to the drawing 

pane. 

9. Polygon Tool : Polygon Tools is used to draw polygon.

10. Dodge Tool : Dodge Tool is used to lighten area of the 

image.

11. Horizontal Type Tool : Horizontal Type Tool is used to 

type text horizontally.

12. Slice Tool : You can create user defined slices with the 

Slice Tool.
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 Lesson 5 : More about Adobe Photoshop

A. Multiple choice questions: 

1.  Repair 2. Cloning

3. Blur, Sharpen and Smudge 4. Burn

5. Background Eraser 6. Magic Eraser

B. State true or false :

1. False 2. False

3. True 4. False

5. True

C. Fill in the blanks : 

1. healing brush 2. cloning

3. Dodge 4. sponge

5. selection tool

D. Answer the following questions in short: 

1. The healing brush allows the user to select an area of an 

image and remove blemishes. 

The patch tool can be used to easily remove unwanted 

objects from an image.

2. The pattern stamp adds texture to an image.

3. Tolerance specifies the tools sensitivity. The lower the 

tolerance number the lower the number of like color 

pixels chosen. The larger the tolerance number the 

greater the number of color pixels or ranges is chosen.     

4. There are four text tools: horizontal text, vertical text, 

horizontal mask tool, vertical mask tool.

5. Filters are effects that can be added to an overall image.

a. Choose an image that the filter will be applied to

b. Choose the filter options from the pull down 

menu labeled Filters
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E. Answer the following questions in detail :

1. The cloning tools allow the user to copy images within 

a graphic or use items within the image to replace other 

images.

a. Choose the Cloning Tool

b. Holding down the alt key and pressing the mouse, 

you make a selection area to choose your image 

from.

c. Release the alt key and the mouse, position the 

mouse over the area that you wish the cloned 

image to appear, click and begin to paint. This tool 

work similar to the healing brush.

2. These tools will do the process as they are described by 

name. These tools are used to blend object together or 

to hide imperfections.

Each one of these tools works through the use of a 

paint brush and the options for each tool can be set to 

allow for small or large areas.

3. Dodge tool will lighten the image as it is painted on the 

screen. The Burn tool will darken the image or give a 

burned effect to the image.

4. Replacing Part of an Image

✎. Using a selection tool, create the selection that

you want to remove

✎. Open the image that will be the replacement

✎. Draw a selection area on the new image

✎. Choose Edit Copy

✎. Return to the first image and choose Edit

✎. Select Paste Into

5. There are three different eraser tools: eraser, background 

eraser, and magic eraser.
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✎ The eraser tool is used to erase object on the 

canvas

✎ The background eraser is used to erase with 

tolerance and to erase background objects on 

layer without affecting foreground objects.

✎ The magic eraser erases using pixels.

F. Define the following :

1. Repair Tool :  The repair tools include the healing brush 

and the patch tool.

2. Cloning Tools : The cloning tools allow the user to 

copy images within a graphic or use items within the 

image to replace other images.

3. Eyedropper : The eyedropper tool is used to select a 

colour from an image or any Photoshop documents.

4. Magic eraser : The magic eraser is best used when you 

want to erase a large area that is in the same color 

scheme.

5. Burn Tool : The burn tool will darken the image or give 

a burned effect to the images. 

 

 Lesson 6 : Flash

A. Multiple choice questions: 

1.  Internet 2. Flash

3. Web 4.   HTML

5. layers 6. Panels

B. State true or false :

1. True 2. True

3. False 4. False

5. True 6. False

C. Fill in the blanks : 

1. web 2. unique
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3. movie 4. Timeline

5. visible 6. lasso

7. smooth

D. Write the key/key combination for the following :

1. F5 2. Ctrl + R

3. F8 4. Ctrl + G

5. Ctrl + B 6. Ctrl + R

E. Answer the following questions in short: 

1. The default dimension size of a stage is 550 × 400 pixels.

2. The default frame rate is 24fps.

3. Extension of Flash Movie file is .swf.

4. Extension of Flash player file is .swf.

5. .fps stands for frames per frames per second i.e. the 
number of images displayed in succession per second.

6. The Pencil Tool draws lines in three different modes : 
straighten, smooth, ink.  

F. Answer the following questions in detail :

1. Flash is one of the most popular technologies on the 
Internet, which has created a way of including 
multimedia on web. It is the gateway to the state of art 
web contents. It is a stand-alone piece of software for 
producing and delivering high-impact multimedia and 
web experiences.

Flash is one of the best multimedia formats on the 
Internet today for following reasons : 

✎ Interactivity 

✎ Cross-Browser Compatibility

✎ Creativity 

2. Stage is an area where you directly draw or arrange or 
import enquired artwork from other sources to create a 
movie. 



22

3. The Timeline organises and controls a movie's content 
in layers and frames. The essential components of the 
Timeline are layers, frames and the play head.  

4. Library in a Flash movie stores symbols, including those 
created in Flash and those imported into it. It allows you 
to view and organize these files as you work. The Library 
window displays a scroll list with the names of all the 
items in the library. An icon next to an item's name in 
the library window indicates the item's file type.  

5. Properties Panel is placed just below the Stage and 
appears by default when Flash is launched. Using the 
Properties Panel, you can easily manipulate all your 
movie contents from one place.

The Properties Panel is contextual; it changes with the 
type of tool chosen.

6. Symbols are reusable elements that you use in a movie. 
There are three types of symbols: Graphic, Button and 
Movie. When you create a symbol, it is stored in the 
Flash library. When you place a symbol on the Stage 
from the library, you create an instance of that symbol 
i.e. a copy of the symbol. 

When a particular element is required more than once 
in a movie. By converting the element into a symbol, we 
can simply drag it from the library to the stage each 
time we need that element i.e. the instance of that 
symbol.

7.  It allows to make an object move across the stage, 
increase or decrease the size, rotate, change color or 
change shape. Animations, like movie films are made up 
of many frames, each of which has a slight change from 
the last one. 

8. There are two methods for creating an animation 
sequence in Flash : 
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• Frame-by-Frame Animation

• Tweened Animation 

Frame-by-Frame Animation : In frame-by-frame 
animation we create the image in every frame. This is 
the most time consuming method,

Tweened Animation : Creating an animation by using 
frame-by-frame technique requires lot of work and 
attention

9. Flash has three types of Tweenings 

Motion Guide Tweenings : Moving objects from 
position A to B along a customized path. 

Tint Tweenings : It includes going from one keyframe 
to another while taking small steps for each of frame in 
between. 

Shape Tweenings : Graduated change in the shape of 
an object into another shape. 

10. Motion Guide Tweenings : Moving objects from 
position A to B along a customized path. 

Tweening simply means going from one keyframe to 
another while taking small steps for each of the frames 
in between. Sometimes you want to add an effect that 
is graduated over several frames. 

For example, Sun moves from the left side of the screen 
to the right side. Instead of moving a sun a little bit in 
each frame, you can simply position the sun on the first 
frame and then insert a keyframe where the sun should 
stop and finally instruct Flash to tween between the 
two keyframes. 

11. A keyframe is a frame in which you define a change in 
an animation and include frame actions to modify a 
movie. 

12. Shape Tweenings : Graduated change in the shape of 
an object into another shape. 
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F. Arrange the following steps in correct order :

S 1 : Draw the Sun and convert it into a symbol (F8) select 
the Graphic option and name the symbol as Sun I. 
Delete it from the stage. 

S 2 : Move to the Library panel and drag the sun onto the 
stage. 

S 3 : To enter a keyframe in frame 20, click the frame 20 and 
then press F6. 

S 4 : Now right-click the 1st frame in the Timeline and select 
Create Motion Tween from the pop-up menu . 

S 5 : In the frame. move the sun to a different position i.e. 
right side of the stage. 

S 6 : Select the 10th frame and insert a Keyframe (F6) and 
move the sun to another different location say, above 
the current position to create a motion sequence 
(automatically tweened by Flash) as shown below:  

S 7 : Save your work and test the Movie (Ctrl + Enter). Finally 
you have created simple animation using Motion 
Tween. 

Lesson 7 : Advanced Features of HTML

A. Multiple choice questions: 

1.  Ordered 2. SRC

3. ALT 4. JPEG

5. Target

B. State true or false :

1. True 2. False

3. True 4. False

5. True 6. False

C. Fill in the blanks : 

1. src 2. <img>

3. GIFs, JPEGs 4. Hyperlinks
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5. href 6. <input>

7. Table columns 

D. Answer the following questions in short: 

1. HTML offers three different type of lists.

a. Ordered list

b. Unordered Information 

c.       Definition List

2. Links that take you directly to other pages and even 
specific parts of a given page. These links are known as 
hyperlinks.

3. Target attribute, define where the linked document will 
be opened. By default, the link will open in the current 
window.

4. A table element consists of three different HTML, tags 
including the <table> tag, <tr> (table rows) and the 
<td> (table columns) tags.

5. The <input> element, is used to select user information.

E. Answer the following questions in detail :

1. Empty Elements : These elements are called empty or 
void elements and only have a start tag since they can't 
have any content. They must not have an end tag in 
HTML. Instead they do something on their own. For e.g. 
<BR> tag breaks the line and displays the text from the 
next line. 

Container Elements : In HTML, the container is the 
area enclosed by the beginning and ending tags. For 
example: <HTML> encloses an entire document while 
other tags may enclose a single word, paragraph, or 
other elements. In HTML code, all container must have 
a start and stop tag to close the container. 

For example : <HTML>  -- </HTML>

2. A definition list may contain numerous terms and 
descriptions, one after the other.
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A definition list starts with a <DL> tag (definition list).

Each term starts with a <DT> tag (definition term).

Each description starts with a <DD> tag (definition 
description). 

Inside the <dd> tag, you can put paragraphs, line breaks, 
images, links, other lists, etc. 

3. GIFs can have no more than 256 colours, but they 
maintain the colours of the original image. The lower 
the number of colors you have in the image, the lower 
the file size will be.

JPEGs on the other hand use a mathematical algorithm 
to compress the image and will distort the original 
slightly. The lower the compression, the higher the file 
size, but the clearer the image.

4. You can insert any image in your web page by using 
<img>tag. 

The <img> tag is an empty tag, which means that it can 
contain only list of attributes and it has no closing tag.

The src attribute tells the browser where to find the 
image.

5. An anchor can point to any resource on the Web.

The <a> tag is used to create an anchor to link from, 
the href attribute is used to tell the address of the 
document or page we are linking to, and the words 
between the open and close of the anchor tag will be 
displayed as a hyperlink.

6. To create an email link, you will use mailto: plus your 
email address. Here is a link to ACC's Help Desk: 

<a href="mailto:helpdesk@austincc.edu">Email Help 
Desk</a> 

7. Radio buttons let a user select ONLY ONE of a limited 
number of choices :
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<form>

<input type = "radio" name = "sex" value = " male"> 
Male <br>

<input type = "radio" name = "sex" value = " female"> 
Female <br>

</form>

Lesson 8 : Artificial Intelligence (AI)

A. Multiple choice questions: 

1. Pattern recognition

2. AI

3. CV

4. Making a machine intelligent

5. Humans

6. Big data

B. State true or false :

1. True 2. True 3. True

4. True 5. True

C. Fill in the blanks : 

1. human, machine 2. NLP

3. Computer vision 4. smaller

5. space

D. Answer the following questions in short: 

1. Artificial Intelligence is the branch of computer science 
that aims at creating expert and intelligent computer 
system.

2. AI’s can be defined as massive amount of stored data 
which when analysed properly could reveal valuable 
insights into industry to which data belongs. 

3. NLP stands for Natural Language Processing, is the study 
of methods by which computers can recognize and 
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understand spoken or written human language.

4. A subset of mainstream AI that deals with science of 
making computers or machines visually enabled.

5. Self driving cars uses computer vision to examine 
surroundings and plan its path.

E. Answer the following questions in detail :

1. Some main areas of application of AI are :

Natural Language Processing : It is the study of 
methods by which computers can recognize and 
understand spoken or written human language. Speech 
recognition software are an example of NLP where 
computer translate spoken speech into text.

Pattern Recognition : This type of software comprises 
of a camera and software which together identify 
repetitive patterns and establish connections between 
the patterns stored in the database and the perceived  
patterns. Finger print identification and automatic voice 
recognition software are some examples of pattern 
recognition software.

2. Various advantages of artificial intelligence are :

a. Process Automation : Human have the tendency 
to get bored while performing repetitive tasks, 
which can alter their productivity. Such tasks can 
be done by intelligent machines.

b. Quick Decision Making : The speed at which 
human take decision is much smaller than AI 
systems

3. It can be defined as massive amount of stored data 
which when analysed properly could reveal valuable 
insights into industry to which data belongs. 

Internet is biggest data provider of consumer habits, 
likes and dislikes, activities and personal preferences 



29

which were otherwise not possible.

Social media accounts, online profiles, product reviews, 
tagged interest, shared content, almost every 
information adds value to big data.

4. NLP stands for Natural Language Processing, is the study 
of methods by which computers can recognize and 
understand spoken or written human language. Speech 
recognition software are an example of NLP where 
computer translate spoken speech into text.

Lesson 9 : Computer Safety and Security 

A. Multiple choice questions: 

1.  disks 2. VIRUS

3. Software 4. Viruses

5. pen drives 6. boot

7. script 8. computers 

B. State true or false :

1. True 2. False

3. True 4. True

5. False 6. True

C. Fill in the blanks : 

1. Hardware 2. access, deleted

3. appearing 4. Macro virus

5. Hacking 6. Phishing

7. Biometric 8. firewall, security 

D. Answer the following questions in short: 

1. Software attacks (logic bombs, Trojans, worms and 
viruses) are deliberate and can also be significant. 
Software threats can be general problems or an attack 
by one or more types of malicious programs. 
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2. A virus is a piece of code or program developed to 
corrupt the data or program files stored on computer 
system. 

3. Hacking is to practise of modifying the features of a 
system, in order to accomplish a goal outside of the 
creator's original purpose. 

4. A Trojan horse, or Trojan, is a hacking program that is a 

non-self-replicating type of malware which gains 

privileged access to the operating system while 

appearing to perform a desirable function but instead 

drops a malicious payload, often including a backdoor 

allowing unauthorized access to the target's computer.

5. Encryption is a very sophisticated security measure used 

in scenarios where security measures are extreme. A 

code language is developed and transmitted to the 

receiver. This is called encryption.

E. Answer the following questions in detail :

1. Antivirus is a kind of software used to prevent scan, 

detect and delete viruses from a computer. Once 

instald, most antivirus software runs automatically in the 

background to provide protection against virus attacks. 

Eg. Norton, MCAfee. 

2. This virus loads itself to the boot sector of the floppy 

disk or master record of hard disk in order to be loaded 

to the memory before the operating system is loaded. 

As soon as the virus becomes residence it will be able to 

infect each inserted disk to that computer. 

3. Following precautions should be taken to secure and 

protect important data –

a. Back up your data.

b. Use strong passwords and multi-factor 

authentication. 

c. Be aware of your surroundings.
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d. Be aware of suspicious e-mails.

e. Install anti-virus and malware protection.

f. Protect your device. 

4. Phishing is a very specific type of cybercrime that is 

designed to trick you into disclosing valuable 

information such as details about your bank account or 

credit cards. Often, cybercriminals will create a fake 

website that looks just like a legitimate site such as a 

bank's official website. The cybercriminal will try to trick 

you into visiting their fake site typically by sending you 

an email that contains a hyperlink to the fake site. 

When you visit the fake website, it will generally ask you 

to type in confidential data such as your login password 

or PlN.

5. A firewall is a security device that can be a software 

program or a dedicated network appliance. The main 

purpose of a firewall is to separate a secure area from a 

less secure area and to control communications 

between the two. A firewall is a system designed to 

prevent unauthorized access to or from a private 

network. You can implement a firewall in either 

hardware or software form, or a combination of both. 

Firewall prevent unauthorized Internet users from 

accessing private networks connected to the Internet.

6. Computer virus is a piece of code or program developed 

to corrupt the data or program files stored on 

computer system. Two type of viruses are :

File-infecting virus : This virus technique is to attach 

itself to the executable files, which are the files ending 

with .exe, .com, .all, and .drv, and these are the main 

program files and drivers.

Boot sector virus : This virus loads itself to the boot 

sector of the floppy disk or master record of hard disk in 

order to be loaded to the memory before the operating 
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system is loaded. As soon as the virus becomes 

residence it will be able to infect each inserted disk to 

that computer. 

F. Write a line about the following : 

1. File-infecting virus : This virus technique is to attach 

itself to the executable files, which are the files ending 

with .exe, .com, .all, and .drv, and these are the main 

program files and drivers.

2. Boot sector virus : This virus loads itself to the boot 

sector of the floppy disk or master record of hard disk in 

order to be loaded to the memory before the operating 

system is loaded. As soon as the virus becomes 

residence it will be able to infect each inserted disk to 

that computer. 

3. Macro virus : Macro virus is a type of mini-program 

that can easily infect a particular computer system. 

Macro virus runs inside another program. Macro virus 

possesses immense ability to spread in a swift manner 

thus infecting popular applications used for everyday 

computing purposes. 

 4. Script virus : This type of virus is written using script 

languages. They spread and infect files by taking 

advantage of vulnerability- ties in the Microsoft 

Windows operating systems; opening e-mails or 

accessing web pages.

5. Polymorphic virus : This virus has the ability to change 

each time it replicates using different encryption 

routines through its additional unique mutation engine.


